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Chapter 1. Release Notes for version 12.1.5
Contains information about new features, defect fixes, and known issues in Unica Campaign 

and Optimize that HCL releases as part of a scheduled software release.

System requirements and compatibility
Unica Campaign  is part of the Unica  suite of products. Unica Campaign  version 12.1.5 

requires Unica Platform  12.1.5

Where to find complete system requirement and compatibility information

For a list of Unica  product versions compatible with this product and a list of third-party 

requirements for this product, see the Recommended Software Environments and Minimum 

System Requirements  document.

You can also access this document by selecting Help > Product documentation  when you 

are logged in to Unica.

Prerequisites for using Unica Campaign
Before you begin using Unica Campaign, confirm that your environment meets the following 

requirements.

• For an improved user experience, use at least a 21" screen.

• For an improved user experience, set your screen resolution to 1600 x 900. Lower 

resolutions can result in some information not being properly displayed. If you use a 

lower resolution, maximize the browser window to see more content.

• A mouse is best for navigating in the user interface.

• Do not use the browser controls to navigate. For example, avoid using the Back and 

Forward buttons. Instead, use the controls that are in the user interface.

• If pop-up blocker (ad blocker) software is installed on the client machine, Unica 

Campaign  might not function properly. For best results, disable pop-up blocker 

software while running Unica Campaign.
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• Ensure that the technical environment meets the minimum system requirements and 

the supported platforms.*

• The correct browser and versions must be used.*

• Clear the browser cache after upgrading or applying any fix pack. This only needs to 

be done once, after the application is updated.

• If you use Internet Explorer (IE) with Unica Campaign  or any module that uses 

Unica Campaign  flowcharts (Unica Deliver, Unica Optimize, Unica Interact, Unica 

Collaborate): To log in multiple times to view side-by-side information, open IE and log 

in to Unica. Then select File  > New Session  in the IE menu bar. In the new IE browser 

window, log in to Unica  as the same or a different user.

Important:  Do not use any other method to open multiple sessions. For 

example, do not open a new tab; do not open another browser session from 

the Start  menu or desktop icon; and do not use File > New Window  in IE. 

These methods can corrupt information that is shown in the application.

*For details on the items indicated by an asterisk, see the Unica  Recommended Software 

Environments and Minimum System Requirements.

Unica Campaign  documentation roadmap
Unica Campaign  provides documentation and help for users, administrators, and 

developers.

Table  1. Get up and running

Task Documentation

Find out about new features, known 

issues, and limitations

Unica Campaign Release Notes

Learn about the structure of the Unica 

Campaign  system tables

Unica Campaign System Tables and Data Dictio

nary

Install or upgrade Unica Campaign One of the following guides:
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Table  1. Get up and running  (continued)

Task Documentation

• Unica Campaign Installation Guide

• Unica Campaign Upgrade Guide

Unica Insights Reports for Unica 

Campaign

Unica Insights Installation and Configuration Guide

Implement the IBM Cognos®  reports 

provided with Unica Campaign

Unica Reports Installation and Configuration Guide

Table  2. Configure and use Unica Campaign

Task Documentation

• Adjust configuration and securi

ty settings

• Prepare Unica Campaign  for 

users

• Run utilities and perform main

tenance

• Learn about integrations

Unica Campaign Administrator's Guide

• Create and deploy marketing 

campaigns

• Analyze campaign results

Unica Campaign User's Guide

Improve flowchart performance Unica Campaign Tuning Guide

Use Unica Campaign  functions Macros for HCL Unica

Table  3. Integrate Unica Campaign  with other HCL products

Task Documentation

Integrate with Acoustic Campaign and Acoustic Integration Guide for IBM 

Marketing Cloud
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Table  3. Integrate Unica Campaign  with other HCL products  (continued)

Task Documentation

Integrate with Coremetrics Unica Campaign  Administrator's Guide: How to 

configure the integration

Unica Campaign  User's Guide: Targeting IBM Digi

tal Analytics segments in Campaigns

Integrate with Unica Plan Unica Plan and Unica Campaign Integration Guide

Integrate with  Opportunity Detect Unica Campaign  Administrator's Guide: How to 

configure the integration

Opportunity Detect  Administrator's Guide  and Op

portunity Detect  User's Guide: How to administer 

and use the product

Integrate with Unica Deliver Unica Campaign  Installation and Upgrade guides: 

How to install and prepare Deliver components in 

the local environment.

Unica Deliver  Startup and Administrator's Guide: 

How to connect to the hosted messaging re

sources.

Unica Campaign  Administrator's Guide: How to 

configure offer integration.

Integrate with IBM SPSS Modeler Ad

vantage Enterprise Marketing Man

agement Edition

Unica Campaign  and IBM SPSS Modeler Advan

tage Enterprise Marketing Management Edition In

tegration Guide

Integrate with IBM WeatherFX. You can integrate IBM WeatherFX with Campaign 

so that you can pull weather events into your mar

keting campaigns. Unica Campaign version 9 and 

version 10 users can integrate with WeatherFX by 

using the UBX toolkit.
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Table  3. Integrate Unica Campaign  with other HCL products  (continued)

Task Documentation

Integrate with  Unica Director. Unica Director Installation Guide: You can inte

grate  Unica Director with  Campaign so that you 

can get status of all the running/completed/failed 

flowcharts, migrate Campaigns from one Unica 

Campaign  environment to other, download/delete 

flowchart logs etc.

Integrate with Journey Unica Campaign can integrate with Journey so that 

a continuous communication with users can be es

tablished based on the inputs from Campaign.

Refer Campaign Administrators guide > Unica 

Campaign and Unica Journeys integration

Integrate with Link Unica Campaign uses Link capabilities of connec

tors which include the configuration and provision

ing to connect to any delivery channel.

Refer Campaign Administrators guide > Unica 

Campaign and Unica Link integration

Integrate with Segment Central Unica Campaign can integrate with Segment Cen

tral so that a segments can be created and man

aged based on the inputs from Campaign.

Integrate with Audience Central Unica Campaign can integrate with Audience Cen

tral so that a audiences can be identified and man

aged based on the inputs from Campaign.

Note:  Additional integrations may be available that are not listed in this table.
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Table  4. Develop for Unica Campaign

Task Documentation

Use the REST API See the Unica Campaign REST API

Use the SOAP API • See the Unica Campaign SOAP API Specifi

cation

• JavaDocs in devkits\CampaignSer

vicesAPI

Develop Java™ plug-ins or com

mand-line executables to add valida

tion to Unica Campaign

• See the Unica Campaign Validation PDK 

Guide

• Java-docs in devkits\validation

Table  5. Get help

Task Instructions

Open online help When using the Unica Campaign  application:

1. Choose Help > Help for this page  to open a 

context-sensitive help topic.

2. Click the Show navigation  icon in the help 

window to display the full help.

You must have web access to view context-sensi

tive online help. Contact  Support for more infor

mation about accessing and installing  Knowledge 

Center locally for offline documentation.

Get PDFs When using the Unica Campaign  application:
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Table  5. Get help  (continued)

Task Instructions

• Choose Help > Product documentation  to 

access Unica Campaign  PDFs.

• Choose Help > All Unica  documentation  to 

access all product PDFs.

• Click the links for PDFs during the installa

tion process.

New features and changes in version 12.1.5
Unica Campaign  12.1.5 includes a number of new features and changes. These are listed 

underneath.

For a list of newly supported and discontinued platforms, see the Recommended Software 

Environments and Minimum System Requirements guide.

Upgrade Paths

Unica Campaign supports the following upgrade paths:

• 12.1.x →  12.1.5

• 12.1.0.x →  12.1.5

Customers on versions earlier than 8.6.x must:

• perform a Fast Upgrade from existing version to version 8.6.0 (for more information, 

see HCL Unica 8.6.0 Fast Upgrade Guide).

• perform a Fast Upgrade from version 8.6.0 to version 12.1.0 (for more information, 

see HCL Unica 12.1.0 Fast Upgrade Guide).

• perform an in-place upgrade from version 12.1.0 to version 12.1.5.

Customers on versions earlier than 11.1.x.x can:
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• perform a Fast Upgrade from existing version to version 12.1.0 (for more information, 

see HCL Unica 12.1.0 Fast Upgrade Guide).

• perform an in-place upgrade from version 12.1.0 to version 12.1.5.

Customers on versions 11.1.x.x/12.0.x.x can use one of the following options for upgrade:

• Option 1

◦ perform an in-place upgrade from existing version to version 12.1.0.

◦ perform an in-place upgrade from version 12.1.0 to version 12.1.5.

• Option 2

◦ perform a Fast Upgrade from existing version to version 12.1.0 (for more 

information, see HCL Unica 12.1.0 Fast Upgrade Guide).

◦ perform an in-place upgrade from version 12.1.0 to verison 12.1.5.

Option to Lock a Flowchart

In Unica Campaign V12.1.5, we now have an option to lock and unlock flowcharts, resulting 

in easier control over flowcharts.

Last Run time indication for Test Run in toolbar

Unica Campaign V12.1.5 now shows last run time for Test as well as Production run, with 

colour coded indicators.

Visual Indication if process box has derived field definitions

Unica Campaign v12.1.5 now shows an icon over Process Boxes having derived field 

definitions for easier identification.

External callout

Unica Campaign v12.1.5 introduces new a Process Box named Callout, which is used to 

trigger the Callout implementations provided by Customer. This is achieved via Campaign - 

External Callout Integration.

Mail-list and Call-list publish to Kafka

Unica Campaign V12.1.5 now supports publishing to Kafka via Mail-list and Call-list PB
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Allow to select the Input before profiling

Unica Campaign V12.1.5 now allows to select input before profiling, earlier his was default 

to None.

Redirect to copied flowchart

In Unica Campaign V12.1.5, after copying a flowchart user gets redirected to the copied 

flowchart.

Earlier user use to remain on the original flowchart and had to manually traverse to the 

copied flowchart.

Kerberos Authentication with Kafka from Unica Campaign

Unica Campaign V12.1.5 now supports Kerberos Authentication with Kafka

OpenSSL 3.0.7

Unica Campaign V12.1.5 now uses OpenSSL 3.0.7, which is the latest FIPS compliant 

version

Fixed defects in Unica Campaign
The following defects were fixed in Unica Campaign  12.1.5.

Issue ID Description

HMA-349463 MailingList process losing offer assign

ment when Deliver process box is added 

to Flowchart canvas

HMA-349265 Campaign listener crashing intermittently

HMA-349158 unica_acclean fails to delete tables from 

SNOWFLAKE database if temptableprefix 

is defined

HMA-347983 Insufficient Disk Space for EXTRACT but 

flowchart ran successfully
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HMA-347621 Teradata connection issue with Unica 

12.1.4 on AIX

HMA-347421 Issue with custom macros during flow

chart execution

HMA-347276 Flowchart processes going into Hung 

state after upgrade to v12.0

HMA-347029 List of Supported Data Type with Google 

Big Query missing from Campaign Admin 

Guide

HMA-346937 Bad rendering of table mappings after mi

gration to Unica 12.1.4

HMA-346893 Extract PB creating huge temp files

HMA-346793 Flowchart approval API call made needs 

to use relative path, not absolute path 

when Plan integrated to Campaign and 

SSL enabled

HMA-346313 Flowchart getting crash when using de

rived fields with date macro

HMA-346134 Audience ID is not showing in Select 

process box

HMA-345922 Incorrect version mentioned in Campaign 

Upgrade guide

HMA-345689 Error:10404 appears for a flowchart when 

flowchart opened in view mode when its 

in running state. : Concurrent user defect

HMA-345642 Issue on sample process box

HMA-344601 Performing Branch Run of flowchart does 

not use Current Value user variables like 
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Full Flowchart run or Single process box 

run

HMA-344172 Colon not removed from URL navigation 

string when Port value specified as blank 

during install

HMA-341413 UA_SYSTEM_TABLES configurations get 

wiped out.

HMA-338263 Offer Assignments Do Not Persist with 

multiple cells in mail list process box

HMA-335243 dll files missing which are needed to run 

MKService_rct.bat

HMA-327423 Flowchart deleted from UA_Flowchart ta

ble while .ses file remains for no apparent 

reason

HMA-290904 VER11.2 - Irrelevant flowcharts turned up 

in a Campaign

Known issues in Unica Campaign
Unica Campaign  12.1.5 includes the following known issues.

Issue ID Description

HMA-341409 OneDB : When the character column type 

length is 255 bytes then the datatype 

should be varchar and if it is more than 

255 bytes than the datatype should be 

lvarchar in Campaign OneDB system ta

bles. This change improves the perfor

mance of Campaign.
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HMA-347611 For Session FC Profiling is not happening 

with Input as Interaction PB

HMA-348276 "Save & Run only Blue process boxes" 

Stops The Execution & Shows Error For 

Red Process Boxes

HMA-349431 Concurrent user : logout limitation

HMA-349754 Callout process configuration issue

HMA-349764 Incorrect Column "V" Shown In Callout 

Field

HMA-349765 FileNotFound Exception For Some Internal 

Temp.csv File In Logs

HMA-349766 Test Run Not Executable For Callout When 

The Rows In Input Are Less Than 10

HMA-349754 Callout process configuration issue

HMA-349764 Incorrect Column "V" Shown In Callout 

Field

HMA-349765 FileNotFound Exception For Some Internal 

Temp.csv File In Logs

HMA-349766 Test Run Not Executable For Callout When 

The Rows In Input Are Less Than 10

HMA-344743 Planning tab is not displayed after clicking 

on Strategies tab

HMA-344732 Flowchart Running Icon on toolbar keeps 

spinning even when flowchart is in 

Paused state

HMA-344710 Blank Frame Shown In Segment If Its Not 

Used/Relevant In Other Campaigns
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HMA-344476 Search optimize session not working 2nd 

time

HMA-343764 Weblogic : partial Error messages are dis

played for Campaign Error messages

HMA-343533 Checkbox & Label alignment issue on All 

Optimize sessions page

HMA-342778 Publish Offer - Campaign- Contact are not 

getting generated as per package id in 

Campaign table for multiple offers

HMA-327170 For Docker environment, getting a "Failed 

to load data" error on Schedule manage

ment page if user continuously clicks on 

pagination (Next button).

HMA-338254 BigQuery database : Cell size limit causing 

the Flowchart to hang

HMA-337564 BigQuery : table mapping, default string 

size is taken as Maximum

HMA-330433 User is not able to login to platform after 

upgrade to 12.1.1 in case Deliver is con

figured.

Resolution

Execute below query on Platform data

base :

select * from usm_role_role_map where 

role_id = (select ID from usm_role where 

name='Deliver_admin' and applica

tion=101 and partition_id=<>)
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Specify actual partition id in above query , 

default for partition1 , partition id =1 , it 

varies for multiple partitions.

If above result in more than one row , con

tact HCL support to help in executing be

low delete query - delete one of the dupli

cate record of *D*eliver_admin role by run

ning below query :

delete from usm_role_role_map where 

role_id = (select ID from usm_role where 

name='Deliver_admin' and applica

tion=101 and partition_id=<>) and parent_

role_id=<partition_id>

For example , for partition id =1 ,

delete from usm_role_role_map where 

role_id = (select ID from usm_role where 

name='Deliver_admin' and applica

tion=101 and partition_id=1) and parent_

role_id=1

HMA-332306 Jboss7.3 : Getting "UT005023: Excep

tion handling request to /unica/servlet/

ScheduleProcessor: java.lang.NoClass

DefFoundError: oracle/sql/BLOB" error 

when user tries to schedule Campaign 

flowchart.

Resolution:

Run the below command to make the 

module global using jboss-cli.sh/bat

_/subsystem=ee:write-attribut

e(name=global-modules,value=[
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{name=com.oracle.jdbc}

]_

OR

1. In <JBOSS_HOME>/standalone/config

uration/standalone.xml searched module 

name for driver.

<driver name="oracledriver" module="ora

cle.jdbc">

<xa-datasource-class>oracle.jdbc.Oracle

Driver</xa-datasource-class>

</driver>

2. Then add the below statement under

neath <subsystem xmlns="urn:jboss:do

main:ee:4.0"> to make the module name 

global.

<global-modules>

<module name="oracle.jdbc"/>

</global-modules>

3. Restart JBOSS server.

HMA-306095 Production documentation links on Cam

paign installer are broken. See the docu

mentation available along with product in

stallers.

HMA-310126 eMessage instances in Campaign unin

stall folder – these can be ignored. Unica 

no longer support eMessage.

HMA-312299 Campaign or Platform navigation url when 

contains default http or https port then re
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cent menu’s does not work. If you are us

ing default http (80) or https (443) ports in 

navigation url please remove them.

HMA-312231 Campaign swagger APIs will not work on

ly on swagger page when marketing plat

form login method is set to Web Access 

control.

HMA-13460 When the Export to File option is 

unchecked on the Fulfillment tab of the 

Mail List process, the Summary File op

tion is enabled but should not be.

HMA-175825 When defaultBehaviorWhenOutputTo

File  is set to Create New File, it works 

only when you select a new output (ex

port) file for the first time. If you try to 

change the existing output file and select 

a new output file, then the option Append 

to Existing Data  gets selected by de

fault. It can be changed manually to Cre

ate New File.

APAR 198495, PO05293, 198494 For a custom macro, if a user account has 

assigned as Not Granted permission for 

a stored object (Custom Macros, Flow

chart Templates, Stored Derived Fields, 

etc.), the custom macro can be used to 

edit, delete, add, move all stored objects 

regardless of permissions.

HMA-204347 LARGE_DATA: Browser Crash - Mail List 

process box with 700 segments - Save 

with 512 offers to each segment.
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HMA-211253 File-based input with multiple columns 

containing date in different format does 

not read the date correctly.

HMA-212890 Boolean type column on Amazon Redshift 

is recognized as 'Test' field type in table 

mapping.

HMA-220474 When the column name of the source 

table contains Non-ASCII characters 

and is long (probably longer than 10 x 

3bytes characters in UTF8), the Snapshot 

process does not run because the temp 

table is not created.

HMA-220705 Profiling count for Dimension table fields 

is incorrect and profiling percentage is 

displayed as 100% even if profiling is in 

progress.

APAR 222047, PO06172, 222049 Unica Campaign extract process does not 

write to DB2 database when flowchart is 

configured with two extract processes 

and the second extract process contains 

a derived field that uses French accent

ed characters in the name of the derived 

field.

APAR 225568, PO06304, 225572 temptablepostexecutionsql  is not run 

when selecting coremetrics segment.

HMA-230340 Inconsistent behavior for the Mail list 

process is observed when the data filter is 

assigned to Effective date  on the Parame

ters tab in a new Mail list process when 

compared to an edited existing Mail list 
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process. The Mail list process does not 

output a datetime derived field in the out

put log file. Changing the effective date 

parameter values might cause execution 

failure of the Mail list.

HMA-230606 In a flowchart where fields are extracted 

and used in a Mail list process, the fields 

under Extract Node on the Personalization 

tab of the Mail list process are different 

before and after running the process.

HMA-231859 While using the Chrome browser, it takes 

around 20 seconds to respond while load

ing the Personalization tab of the Mail 

list process if it contains large number of 

treatments and offers assigned. For ex

ample, a Mail list process with 250 cells, 

each cells with multiple offers, each offer 

having multiple attributes.

HMA-232502 A Mail list performance issue occurs 

when the user changes the input in any 

way and there is a delay when initially 

switching tabs. After the user changes 

the input and switches to the Treatment 

or Process tab for the first time, there is 

a delay of around 10-15 seconds depend

ing on the number of inputs selected. Af

ter this initial delay, there is no delay until 

the input is changed.

HMA-232835 The Campaign application performance 

is affected and sometimes an exception 

error message is displayed on the Cam
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paign pages when the application is used 

for a longer time (some days) with contin

uous usage. You must restart your Cam

paign web application and Campaign Lis

teners.

HMA-238789 While using the Chrome browser, when a 

user opens a Mail list with 600 cells hav

ing multiple offers assigned to each cell, 

the application stops responding. While 

using the Internet Explorer 11 brows

er, nothing is displayed in the Mail list 

process box.

HMA-239142 When the Audience process fails because 

of an incorrect Count filter expression, 

and the user removes the filter expres

sion, adds a Condition, and runs the Au

dience process again, the process fails. 

The Condition is not considered and in

stead the previous Count filter expression 

is used resulting in the failure. To run the 

Audience process successfully, you must 

re-open the Audience process configura

tion window, click the Condition, Save and 

Close. The Audience process now consid

ers the Condition and runs successfully.

HMA-271642 A "Please wait....."  message is dis

played multiple times in console mode in

stallation while upgrading from version 

10.1 and also for new Installation
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HMA-271676 The Extract table on the DB2 and Oracle 

databases is not deleted when In-DB opti

mization is unchecked.

HMA-272253 The Campaign application performance 

is affected when a user opens the Table 

mapping window and more than 500 ta

bles are mapped.

HMA-2968 Hot keys are not implemented on most of 

the windows. In the Dojo implementation 

it is not possible to use keyboard short

cuts to activate certain functions. Instead 

the user must click buttons.

HMA-PMR 266519, 75262 Clicking Return to previous page distorts 

the user interface in some cases. Use 

the links within the products to navigate, 

rather than the browser controls.

N/A When Unica Campaign is deployed in 

an application server cluster environ

ment with 80 port, the Campaign nav

igation URL should not contain this 

port number. For example: http://

<host>.<domain>:80/ Campaign should 

be changed to http://<host>.<do

main>/Campaign. Change the value of the 

serverURL property under Campaign|nav

igation on the Settings > Configuration 

page.

N/A Mail List process box gets unconfig

ured with error "31606: History table are 

changed" on Flowchart run.
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1. There is no issue if the history ta

bles are mapped prior to building 

a flowchart and adding a Mail List 

process.

2. If you do not follow step 1, you can 

still map the history tables after the 

error appears. If you edit the flow

chart and configure the process 

box, the process will run.

N/A After migrating non-ASCII data to Cam

paign, in some cases you cannot open 

Campaign flowcharts on the target sys

tem. Session flowcharts open successful

ly. To work around this issue, remigrate 

the campaigns in overwrite mode. You 

can then open the flowcharts.

TT 062333 Information related to associated prod

ucts does not appear in offer on Market

ing Operations. When an offer created in 

Campaign with products associated with 

it is imported in Marketing Operations, in

formation about the associated products 

is not available in Marketing Operations.

HMA-270655 Table Mapping : Table name containing @ 

is supported while mapping a table, spe

cial characters like @ are should not be 

supported in Table names. Since Table 

name containing @ is supported since 

some time, this functioning is not updated 

now.
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HMA-283637 When user has one maillist PB config

ured in the flowchart and he adds anoth

er maillist PB in the same flowchart, it is 

observed that All the values from already 

configured in treatment tab, Parameters 

tab, Personalisation tab of new Maillist PB 

appear automatically in any new dragged 

maillist PB.

HMA-281389 While running Campaign in the Upgrade 

mode, the installer should read the instal

lation properties files from the previous 

version response files as we had that re

sponse available at the install location 

from the previous installation. However, 

it does not read the installation proper

ties files from the earlier version response 

files.

HMA-280623 In Sample PB if we specify '3' in "# of 

Samples/Output Cells" field and Config

ure [sample1] with 3 samples having sam

ple sizes as 50%, 50% and "All remain

ing records" respectively based on "Ran

dom Sample method" then after running 

Flowchart if we reopen the Sample PB 

"Process run results will be lost. Contin

ue?" message is displayed in sample PB 

when remaining All check boxed is check.

HMA-283101 CHROME: "Unable to notify roles/per

mission changes to Campaign, Deliver 

OD may be out of sync". On clicking save 

changes for the Security Policy displays 
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the following pop-up, this happens just 

first time after user logs in and changes 

anything in the policy and clicks save 

changes. Also, this is reproducible just 

on CHROME. Tested on Chrome V64 and 

V65.

HMA-282844 Campaign Offer doesn’t sort on 'Chan

nel' & 'Eff./Exp.Dates'. After clicking on 

every column the offers below it should 

be sorted in ascending order. If you click 

on the same column the second time, the 

offers beneath it should be sorted in the 

descending order.

HMA-283695 Segment process box execution failed 

with extract enabled to User database for 

the IMPALA user DB. This error does not 

reproduce when extracting to Unica Cam

paign server.

HMA-284436 Platform.war and campaign.war in ear 

file deployment will not work in Weblog

ic 12.2.1, work around is to deploy cam

paign.war and unica.war separately.

HMA-288228 If the date field uploaded to IMC side 

is not in mm/dd/yyyy format, the email 

process box fails to execute. This da

ta format is required by IMC Importlist 

API. It works accurately if DELIM_M_D_

YYYY(mm/dd/yyyy) format is used for 

date while uploading to IMC using im

portlist API.
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HMA-289135 TOMCAT : Occasionally Unica Platform 

or Campaign does not gets started after 

deploying in tomcat application server. 

Workaround : delete Campaign and Plat

form directory available inside Tomcat 

webapps directory and delete the con

tent of work directory from the path where 

Tomcat is installed.

HMA-304945 Refresh command does not refresh 

the master listener priority or weight, if 

you need to make changes in priority or 

weight you require to take a downtime 

and restart the application.

HMA-312445 Link Process box - sending data only for 

the first input cell selected to link.

UL-285 Connection Salesforce - Subsequent 

Salesforce actions are failing for Update 

(Lead/Contact) intermittently.

UL-250 Connection Mandrill - Intermittenly stop 

sending emails to targeted audiences.

UL-281 Connection Mandrill - Subject line with 

non english characters - mandrill not 

sending email to user.

UL-259/UL-242 Connection Mailchimp/Mandril - results 

would be available for 1000 users only.

UL-214 MailChimp/Mandril - Audience value is 

getting changed to id field after selection 

or reopening process box.
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UL-194 MailChimp/Mandril - In Mandrill template 

if merging field added as localized charac

ter - personalization is not working.

UL-257 Link Connections page takes time to load 

in the Campaign process box.

UL-231 Twilio Connection - Only 5 fields are sup

ported for personalization in SMS body/

text area.q

UL-279 Connection MailChimp - Branch run or sin

gle link process box run is not support

ed with Link process box with Mailchimp 

connection. You will need to execute com

plete flowchart.

UL-287 Link process box fails when no output da

ta.

NA Unica Campaign and Unica Link applica

tions urls should be having same domain 

names. Unica Campaign and Link applica

tions deployed on different domains will 

not work.

UL-189 Connection Mandrill/MailChimp- Emojis 

are not working in Mandrill and MailChimp 

connector Mail Subject line.

HMA-313650 Platform Scheduled flowcharts are not 

getting executed afterupgrade.Use the 

quartzjobtool to update scheduler jobs. 

This is a requiredstep. If this upgrade tool 

is not run, any existing scheduled job will

fail to start. The quartzjobtool is in the 
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tools\bin directory underUnica Platform 

installation. Run this utility from the tools 

\bindirectory.Example command (Win

dows): quartzjobtool.batExample com

mand (Unix): ./quartzjobtool.sh

HMA-306383 UBX registration utility is failing with error 

Caused by: java.lang.ClassNotFoundEx

ception: org.jboss.logging.BasicLogger er

ror

HMA-316802 MariaDB]:CODE 704: File write error. while 

extracting extracted fields and table fields 

to database server through Segment PB

HMA-338395 v12.1.3: Campaign : Selecting export to 

Kafka makes Snapshot PB unconfigured. 

Needs workaround to run

HMA-338387 For version 12.1.3, the copyright year is in

correct in the Fed Response File Respon

seFiles.tar.gz.

Known issues in Optimize
The following are the Known Issues for Optimize in V12.1.5

Issue Issue ID Description

Scores entered manually in the score 

matrix are not considered while opti

mizing the contact list.

Defect 194109 Scores entered manually 

should be considered for cal

culation in the Customer Ca

pacity rule. However, while 

applying the Customer Ca

pacity rule, scores in the PCT 

are considered, and all cus
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Issue Issue ID Description

tomer records are removed 

in the optimized list.

Campaign Optimize summary report is 

incorrect.

Defect 176368 If offer versions are used in 

a rule, the report that shows 

pre-optimization versus post-

optimization counts will al

ways report the pre-opti

mization count of records 

as 1. The post-optimization 

counts will be correct.

After upgrading Campaign to 9.1, Opti

mize listener can no longer be stopped 

via ACOServer.sh.

Defect 81245 Users must upgrade Unica 

Campaign  and Unica Opti

mize  together. If they can

not, they will need to stop the 

Unica Optimize  listener man

ually through the task man

ager/kill command.

Error messages for the ACOOptAdmin 

utility do not display according to non-

English locales.

DEF051284 When you run the ACOOpt

Admin command line utility 

in a locale other than English, 

error messages do not dis

play according to the spec

ified locale. The error mes

sages display only in English.

unprocessables_sessionid.csv 

might contain some customers who re

ceive offers.

DEF054841 In some scenarios, a few of 

the customers who get of

fers might be present in the 

unprocessables_ses

sionid.csv  file.
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Issue Issue ID Description

Incorrect optimization result with Cus

tom Capacity rule in specific circum

stances.

DEF058362 A customer that satisfies the 

following criteria might re

ceive fewer offers than want

ed:

• The customer has an 

even number of pro

posed transactions.

• Each of these trans

actions has the same 

score.

• This score is a low val

ue.

Some labels display incorrectly in 

Japanese, Chinese, and Korean.

DEF059595 Some translated labels are 

displaying incorrectly. For 

example, when you edit the 

score matrix manually, the 

vertical label on the right 

side of the table displays 

upside down. Also, for opti

mization rules that contain 

customers in the segment, 

the segment  label displays 

on two lines.

Offer filtering summary report displays 

an incorrect count of Proposed Con

tacts that are removed by each Custom 

Capacity rule.

DEF059805 The Offer Summary Report 

displays incorrect counts in 

the "Removed By This Rule" 

column for Custom Capac

ity rules if the participating 

Flowchart for this Unica Op
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Issue Issue ID Description

timize  session contains mul

tiple contact dates and mul

tiple offers that are made to 

each customer on different 

channels.

Issues with offer version query builder. DEF060676 There are several minor is

sues with the offer version 

query builder:

• For custom attribut

es with the Form Ele

ment Type of Select 

Box, the offer version 

query builder does not 

use the select box. You 

must enter the value 

manually.

• When the group level is 

removed, the subgroup 

conditions are added 

to the parent condition, 

and vice versa.

• All arithmetic opera

tors are displayed for a 

string variable, but on

ly equal and not equal 

apply.

• Defined length valida

tions for attributes are 

not verified upon input 

for conditions.
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Issue Issue ID Description

Offer version rules that contain dates 

do not provide expected optimization 

results.

DEF061554 If you create an offer version 

condition that includes a 

date, such as the offer para

meter "valid end date" equals 

"12/31/2011", the rule con

taining offer version condi

tion might not be satisfied; 

however, the rest of the rules 

will work as expected.

Rule exceptions that span calendar 

years give incorrect results.

DEF061639 If you create a rule excep

tion to a Min/Max # Offers 

capacity rule that spans 

calendar years, such as 

07/01/2011 to 06/30/2012, 

the rule containing rule ex

ception condition will not be 

satisfied; however, the rest 

of the rules will work as ex

pected.

<unica_svradm> refresh command 

does not reflect the change.

HMA-304945 On a running environment, 

after changing the master 

listener priority, <unica_

svradm> refresh command 

does not reflect the change.

<unica_svradm> refresh command 

does not delete the node from cluster.

HMA-305764 If you delete a listener node 

from existing cluster, <uni

ca_svradm> refresh com

mand does not delete the 

node from cluster. Execution 

requests are still observed 
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Issue Issue ID Description

going to the deleted node. 

Restarting the listener solves 

this issue. Will be fixed in up

coming fixpack.

Users are still able to manually inter

fere in the running flowchart when 

flowchart execution is in progress 

through SVRADMIN utility.

HMA-306037 When flowchart execution is 

in progress through SVRAD

MIN utility or using sched

uler, user is still able to man

ually interfere in the running 

flowchart. Will be fixed in up

coming fixpack.

Known limitations in Unica Campaign
Unica Campaign  12.1.5 includes the following known limitations.

Issue ID Description

HMA-330347 Users can use Sankey flowchart to view 

waterfall information. This solution is of

fered with certain limitations:

For huge flowcharts, with approximately 

50+ process boxes, clearly displaying all 

process boxes and related flow is difficult. 

The information or labels may get over

lapped and thus look cluttered. Users are 

advised to use zoom in and zoom out fea

ture along with scrollbars to navigate to 

area of interest for better picture.

HMA-291963 Browse table in table mapping feature not 

to be used
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304128 Platform login method or users authenti

cation from third party directory services 

is not supported with Campaign or Opti

mize APIs. Users require to use the Unica 

Platform user to use with APIs.

305130 The flowchart template is not imported, if 

it contains data source name more than 

256 character length. Save the flowchart 

template again by changing the data

source name with less than 256 chars.

305764 For any reason, if users delete the Cam

paign listener node configuration from lis

tener cluster configuration in Unica Plat

form, while the application is up and run

ning then users connected to this listen

er node are not redirected to another lis

tener. You must restart the Campaign web 

application. If you require to delete the lis

tener node, take a downtime and restart 

Campaign web and listener components.

17202 Error 19024: Cannot delete segment fold

er if the segment was deleted from the 

folder. A segment that is deleted from a 

folder remains as an inactive segment in 

the folder. Folders with inactive segments 

cannot be deleted. This is working as in

tended.

185854 Big data: Campaign integration with 

Hadoop-based Hive big data as a user da
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ta source is not tested on MS Windows 

operating system.

190621 Big data: Campaign with Hive big data as 

a user database does not support user 

table mapping with Base and Dimension 

levels up to the fourth level hierarchy. If 

you map a Base record table with four 

levels of dimension tables in a Select 

process box, then build a query based on 

the fourth level Dimension table, the query 

fails with Error 11528. This issue should 

not affect big data users because multiple 

dimensions should not be needed. By de

finition, a big data source has a large ta

ble of records split across Hadoop nodes 

(such as HDFS).

194095 For Redshift database, the error message 

"Unsupported type timestamps with time 

zone" is displayed when exporting data 

from a Snapshot process box. Timestamp 

with timezone is an unsupported Postgre

SQL data type on Amazon AWS.

195581 While running a Campaign flowchart, if lis

tener crashes or is stopped, user is not 

able to access the running flowchart from 

the UI. Requests are being served by an

other node of the cluster but while ac

cessing the flowchart, a pop-up message 

says "listener failover occurred..." It may 

be necessary to restart the master listen

er.
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232032 User can start only one Campaign listener 

on one server (machine) in case of Listen

er clustering.

PMR 243195, 244148 When a column that has the Greek Letters 

A and B is profiled in Campaign, the sys

tem returns only A along with the count 

of all the records. After the fix, some of 

the non-English characters, which differ 

only in case (like é and É in French), are 

counted as two different values in profil

ing. English language characters are not 

counted as case sensitive.

244482 Deep search lists all the Campaigns that 

are created through Marketing Operations 

projects when Campaign - Marketing Op

erations integration is on. Campaigns 

that are created through Marketing Op

erations projects when Marketing Opera

tions - Campaign integration is enabled) 

are not listed on Campaign list page and 

are only available on the Marketing Oper

ations project listing page. Users who do 

not have the permission to access Mar

keting Operations are able to access cam

paigns which are created through Mar

keting Operations projects through Deep 

search results.

248943 If the user profile database is changed 

(change in the table column values of au

dience record) for fields other than sync 

fields and the user runs the Email process 
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again, a negative count is returned for the 

DUPLICATES parameter from Engage in 

the Campaign flowchart log.

N/A Big data: To perform the UPDATE opera

tion on any process boxes in a flowchart, 

ensure that your HIVE tables are config

ured as transactional tables such that 

they support the ACID property. This is 

a key feature introduced in HIVE version 

0.14.

N/A Interact when configured with IBM Web

Sphere Application Server: You must con

figure IBM WebSphere JVM to use JDK 

1.7. When IBM WebSphere Application 

Server 8.5.5.x is configured with JDK 1.7 

and HTTPS communication, you must use 

IBM JAVA SDK version 7.0.8.10 or higher.

N/A Using multiple SQL statements for raw 

SQL queries is not currently supported 

on big data user datasources. For related 

information, search the IBM Knowledge 

Center for Hive query language confor

mance.

N/A Dialog behavior: In certain cases, it is nec

essary to click twice in order to activate a 

field or change a field value.

N/A The monitorEnabledForDeliver  configu

ration property in Campaign|monitoring 

is not currently used.
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N/A Relevant products limitation: When offer 

management is performed from Unica 

Plan, the "relevant products" functionality, 

which relates product IDs to offers, is not 

available.

N/A Blank or incorrect results from derived 

fields in a Mail List process. This can oc

cur in a process box that uses a derived 

field that calls a Generated field (UCGF) 

that changes value.

Do not use a UCGF in a Mail List derived 

field if the UCGF is not constant. Also, 

from the Parameters tab, do not create a 

derived field to call a UCGF to populate of

fer attributes.

N/A Profiling a Campaign Generated Field 

(UCGF) does not yield correct results. 

Some UCGFs have a value according to 

the cell or the offer being processed. For 

cell-related UCGFs, only the value associ

ated with the first cell appears during pro

filing.

N/A The default value for a custom cell at

tribute does not appear when you open 

the target cell spreadsheet. Although the 

default value is not initially displayed, it 

will be used. The value can be displayed 

or changed by clicking or opening and 

editing the custom cell attribute in the tar

get cell spreadsheet.
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N/A The UA_UsrResponseType.Name  field can

not contain a left parenthesis followed by 

a single quote.

N/A Use unique TempTablePrefix  for each da

ta source when mapping multiple data 

sources to same physical database.

If you mapped multiple data sources in 

Unica Campaign  to the same physical 

database, and you use the same TempT

ablePrefix  for more than one of the da

ta sources, when you use the cleanup util

ity to delete orphaned temp tables, it may 

falsely identify temp tables as orphaned, 

when they are in fact legitimate temp ta

bles defined from a different Unica Cam

paign  data source.

Any deleted temp tables will automati

cally be recreated when you rerun affect

ed flowcharts, but as a best practice, use 

a unique TempTablePrefix  for each da

ta source when mapping multiple data 

sources to the same physical database.

If the data sources defined in Unica Cam

paign  map to different schemas in the 

database, another solution is to ensure 

that the database user who runs the 

cleanup utility does not have privileges to 

drop tables in other schemas in the same 

database.

161323 The error "Login failed. Error 10553" can 

occur if you try to log in to the Campaign 
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utilities when the Unica Platform | Secu

rity | login  method is set to Windows in

tegrated login  or Web access control. To 

avoid this issue, change the login type to 

LDAP  or Platform  prior to using the Cam

paign utilities..

176377 DB2 10.5 BLU for user DB: No indexing re

quirement for temp tables in Unica Cam

paign  datasource. DB2 10.5 (with BLU fea

ture ON) does not require indexing in Uni

ca Campaign. Unica Campaign  has cer

tain properties for datasources, such as 

TempTablePreTruncateRunScript, Temp

TablePostExecutionSQL, and PostTempT

ableCreateRunScript, where you can pro

vide SQL or scripts to create indexes on 

user database tables. If you are using DB2 

10.5 as a customer database, with the 

BLU feature ON, you do not need to con

figure any of these temp table properties.

201,968,200,241 If two process boxes are moved very 

close together in a flowchart, the direction 

of the connection arrow changes. This 

limitation affects the visual representation 

of the arrow. The process data flow is not 

affected. The workaround is to move the 

process boxes farther apart so the arrow

head changes back to the correct direc

tion.

211293 In  Unica Campaign, the built-in macro 

Current_Date() results in an error when ex
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ecuted against a Hive 1.2 based Big Data 

instance. The Hive ODBC driver does not 

support the Current_Date macro to obtain 

interval values. For example, executing 

the following query results in a Hive error:

SELECT DISTINCT customerid FROM Cus

tomer_date WHERE ((Customer_date.my_

date_mmdyyyy - CURRENT_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported 

conversion from type: interval_day_time

Workaround: To use the Current_Date 

function in a RAW SQL query on Hive with 

Hortonworks, execute SQL in the follow

ing format:

SELECT DISTINCT customerid FROM Cus

tomer_date WHERE (current_date() - my_

date_mmddyyyy ) = interval '0 0:0:0' day to 

second

310769 In Unica Campaign, the built-in macro 

Current_Date()  results in an error when 

executed against Impala data source. The 

Impala ODBC driver does not support the 

Current_Date macro to obtain interval val

ues. For example, executing the following 

query results in an error:

INSERT INTO TABLE UAC_133824_5 

SELECT DISTINCT store_id, d_customer_

key FROM srvacammo.bast_segment 

WHERE (srvacammo.bast_segment.ba_

last_trans_date > (CURRENT_DATE - 2))
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Error: Error while executing a query in Im

pala: [HY000] : AnalysisException: Could 

not resolve column/field reference: 'cur

rent_date'

Workaround: In raw SQL query, the Cur

rent_Date  would not work with Impala, so 

instead of current_date, users can use 

now()  or current_timestamp().

213088 If Campaign is installed in a secured en

vironment but IBM Cognos is in an unse

cured environment, Cognos reports will 

not display when you use Microsoft In

ternet Explorer 11. Workaround: If Unica 

Campaign is configured with HTTPS, also 

configure IBM Cognos on HTTPS.

217488 IBM can support the Database Loader for 

Redshift until the moment Campaign trig

gers the Loader Script. Any problems in 

execution of the loader script are not sup

ported by IBM.

223716 Authentication Bypass Using HTTP Verb 

Tampering

Instead of applying theHttpVerbFil

ter.class patch, you can use the following 

workaround to ensure application securi

ty.

Complete the following steps to update 

web.xml.
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1. Update the web app tag and set the 

xsd version to 3.0.

<web-app 

 xmlns:xsi="http://www.w3.or

g/2001/XMLSchema-instance" 

 

 xmlns="http://java.sun.com

/xml/ns/javaee"

 

 xsi:schemaLocation="http:/

/java.sun.com/xml/ns/javaee 

 

 http://java.sun.com/xml/ns

/javaee/web-app_3_0.xsd"

  id="Platform" 

 version="3.0" 

 metadata-complete="true">

2. Add the following in web.xml.

<!--[start] WhiteList Http 

 Verbs -->

<security-constraint>

  <web-resource-collection>

 

 <web-resource-name>Unica_Wh

iteList_Http_Verbs</web-reso

urce-name>

 

 <url-pattern>/*</url-patter

n>
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 <http-method-omission>GET<

/http-method-omission>

 

 <http-method-omission>POST<

/http-method-omission>

 

 <http-method-omission>TRACE

</http-method-omission>

 

 <http-method-omission>PUT<

/http-method-omission>

 

 <http-method-omission>DELET

E</http-method-omission>

 

 <http-method-omission>PATCH

</http-method-omission>

 

 <http-method-omission>OPTIO

NS</http-method-omission>

 

 <http-method-omission>HEAD<

/http-method-omission>

  </web-resource-collection>

  <auth-constraint/>

</security-constraint>

<!--[end] WhiteList Http 

 Verbs -->

283805 IBM Websphere Application Server 8.5.5 

Fix Pack 12 requires IFPI85892 to run HCL 

Unica application.
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283544 On Oracle 12.2 database server following 

parameters needs to be added in sqlnet.o

ra file located under ORACLE_HOME/net

work/admin/SQLNET.ALLOWED_LO

GON_VERSION_SERVER

User will need to consult with DBA to pro

vide appropriate value to this parameter. 

Please refer this link for details: https://

docs.oracle.com/database/121/NETRF/

sqlnet.htm#NETRF2016

N/A Campaign Integration with Watson Mar

keting Assistant is not supported on Inter

net Explorer.

286705 Two events get generated on the Cam

paign history tab when user pauses the 

Campaign flowchart from Operational 

monitoring.

287100 History tab data remains in UA_History ta

ble even after deleting the Campaign

290172 Cutting off right contents from Relevant 

offers window.

Workaround: The size of text, apps and 

other items - under Display should be set 

to 100%.

312318 Campaign flowchart run - when executed 

as complete flowchart generates a unique 

runID and its executed the flowchart along 

with mailchimp process box.

https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
https://docs.oracle.com/database/121/NETRF/sqlnet.htm#NETRF2016
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Next time when Campaign user tries to 

run the single process box - it does not 

generate unique runID and thus process 

box execution failed.

312296 HTTPS(Invalid certificate) HIP instance 

is not supported in IE11 for Link PB and 

Manage Link Connections page.

312320 MailChimp - Audience value is getting 

changed to other format f239295fe8 

(in alphanumeric format) if we re-

open correctly configured Link PB. The 

workaround is to hit the Fetch button adja

cent to the field which will refresh the val

ue of the user-friendly string value.

312567 Campaign installer failed to update In

sights report files when installed using 

non-root user on Unix environment. To 

overcome this user would need to update 

Insights report file manually after installa

tion is completed.

1. Navigate to <PLATFORM_HOME>/In

sights/tools/bin/

2. For UNIX:

• Grant read, write, and execute per

missions to -bPath=<Report fold

er path>  for the installation user.

• Grant execute permission to the in

stallation user using the following 

command.

chmod 755 insightsDBUtil.sh
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3. Execute command to update the Cam

paign Insights report files.

./insightsDBUtil.sh -ds=Campaign

DS -bPath=<Report folder path> -DB

Type=<databasetype> -URL=JDBC con

nection URL> -user=<database user> 

-pwd=<database password>

For more details refer UnicaInsights12_

1InstallationConfigurationGuide

313216 Link: Unica application on HTTPS and uni

ca Link on HTTP does not render the Man

age links connections page.

Known limitations in Unica Optimize
Unica Optimize includes 12.1.5 includes the following known limitations.

Issue Number Description

Strings in the production or 

test pop-up window are not 

translated.

Defect 

176920

In the case of a non-English setup, the 

strings in the production or test pop-up win

dow are not translated.

The MailList process fails 

with the following database 

error: ORA-00999: INVALID 

VIEW NAME.

Defect 

170951

Change the value of UseTempTablePool 

from TRUE  to FALSE  in UA_SYSTEM_TABLES. 

The MailList run will end successfully.

Unica Optimize  does not 

terminate the unica_acsvr 

process that is opened dur

ing a run.

Defect 

164875

In case of a schedule run of a Unica Opti

mize  session by using the Unica Platform 

Scheduler, you observe multiple unica_

acsvr  login processes. These processes 

might terminate automatically after some 

time.
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Issue Number Description

A DB2 database user change 

of system tables causes a 

Unica Optimize  session to 

fail when the administrator 

has an index with the same 

name.

Defect 

155876

To avoid having a session fail, the DB2 data

base administrator should remove indexes.

In a Unica Optimize  report, 

offers by type and segment 

do not get printed as de

sired.

Defect 

102889

The following issues were noticed while 

printing the offers by type and segment in a 

Unica Optimize  report.

1. The preview window does not scroll, 

unless it is resized.

2. While printing it does not print every

thing, but only what fits in A4 size. 

Printing options do not seem to make 

any difference.

Negative scores cause inac

curate rules crediting.

DEF041400 If you use negative scores, rule crediting in 

the Offer Filtering Summary report might not 

be accurate.

Offers with negative scores are given to 

meet minimum requirements only.

Cells that are linked to TCS 

with offer assignments 

do not appear in Optimize 

process.

DEF061355 If the Optimize process is connected to one 

or more cells and the upstream cells are lat

er linked to top-down cells defined in the 

Target Cell Spreadsheet process (TCS), 

the offers that are assigned in the TCS do 

not automatically appear in the Optimize 

process. Link to any top-down cells in the 

TCS before you connect those cells to an 

Optimize process. Otherwise, you must ei
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Issue Number Description

ther manually assign the same offers within 

the Optimize process, or delete the Optimize 

process and re-create it.

Running the ACOOptAdmin 

utility with one-way SSL re

quires more setup.

DEF046832 You cannot use the ACOOptAdmin  utility 

with one-way SSL until you register a se

curity certificate, specify a host name and 

domain, and configure SSL_Options in the 

ACOOptAdmin.bat  file.

Unable to run the session in 

first attempt when unica_a

cosvr process stopped.

DEF055010 If you use the kill  command to stop unica_

acosvr, the next time you attempt to run a 

Unica Optimize  session, it might fail with the 

following error: An unknown communication 

failure has occurred with the  Opti

mize server process.

Workaround - Run the Unica Optimize  ses

sion again to complete it successfully.
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